
KEY Description of task

Summary of recommended procedure

Exercise reference(s)

Advanced Filter, in place 19-17
Create criteria range, and name it. Key criteria 
below label. Click in list and choose Data, 
Filter, Advanced Filter. Specify List and Criteria 
ranges and Click OK.

Advanced Filter, to another location 19-17
Create criteria range and name it. Key criteria 
below label. Create output range and name it. 
Click in list and choose Data, Filter, Advanced 
Filter. Click in list and choose Data, Filter, 
Advanced Filter. Specify List and Criteria 
ranges, select Copy to another location. Specify 
Copy to location. Click OK.

AutoFilter, by selection 19-11
Click in cell to be matched. Click the AutoFilter 
button  (if available on toolbar).

AutoFilter, custom  19-14
With AutoFilter on, click the drop-down arrow 
for fi eld and select (Custom...) Choose fi rst 
operator and a value. Choose And or Or if 
desired and set second operator and value. 
Click OK.

AutoFilter, from the list 19-12
With AutoFilter on, click the drop-down arrow 
for fi ltered fi eld and select item to fi lter. 

AutoFilter, Top 10 19-13
With AutoFilter on, click the drop-down arrow 
for fi eld, and select (Top 10...).

Button, remove 13-21
Press and hold a  and drag button from its 
toolbar into the worksheet.

Cell errors, print 11-12
Click the Print Preview button . Click Setup 
and click the Sheet tab. In Print group, choose 
an option for Cell errors as.

Changes, accept or reject 17-9
In a merged workbook, choose Tools, Track 
Changes, Accept or Reject Changes. Select 
Not yet reviewed for When. Click OK. Click 
Accept or Reject for each change.

Changes, print change history 17-6
In a shared workbook, choose Tools, Track 
Changes, Highlight Changes. Select List 
changes on a new sheet. Click OK.

Changes, set change history options 17-2
In a shared workbook, choose Tools, Share 
Workbook. Select number of days for Keep 
change history for. Choose options for Update 
Changes group and Confl icting changes 
between users. Click OK.

Changes, track 17-4
In a shared workbook, choose Tools, Track 
Changes, Highlight Changes. Select Highlight 
changes on screen. Click OK.

Circular reference 11-15
Click OK in message box. Read Help window. 
Edit formula.

Close multiple fi les 16-14
Press and hold s . Choose File, Close All. 
Save workbooks if prompted.

Comment, insert 17-5
Click the New Comment button  on Review-
ing toolbar. Key comment and click another cell.

Compare and merge workbooks 17-7
Choose Tools, Compare and Merge 
Workbooks. Navigate to appropriate folder and 
double-click the fi lename to be merged into the 
open workbook.

Conditional formatting 12-12
Select cells. Choose Format, Conditional 
Formatting. Specify Condition 1 options. Click 
Format and specify format. Click OK twice.

3-D effect 9-11
Select the object and click the 3-D Style button  
on the Drawing toolbar. Choose a style.
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Consolidate data 16-2
Select empty cells for the consolidated data. 
Choose Data, Consolidate. Choose function 
and select Reference box. Click the worksheet 
tab and select fi rst range of cells for consolida-
tion. Click Add. Click each worksheet tab and 
add corresponding ranges. Select Create links 
to source data for a dynamic consolidation. 
Click OK.

Constant, create 11-6
Press Ç +£ . Key constant name in Names 
in workbook text box. Key the value with equals 
sign in Refers to text box. Click OK.

Data form, use 19-4
Click in any cell in named list. Choose Data, 
Form. Press t  to move from fi eld to fi eld. 
Click New to add a record. Click Close.

Data table, One-variable data, create 19-1
Key input values in a row. Key nonchanging 
value in a cell. Key formula one column to left 
of and one row below input values, using any 
empty cell as input cell. Select data table range 
and choose Data, Table. Key input cell for row 
values. Click OK.

Data table, two-variable data, create 19-5
Key fi rst set of input values in a row. Key 
second set of input values in a column. Key 
formula one column to left of row values and 
one row above column values, using two empty 
cells as input cells. Select data table range 
and choose Data, Table. Key input cell for 
row values and input cell for column values. 
Click OK.

Delete a watch 14-7
Select cell reference in Watch Window. 
Press y .

Embed, Word document 18-5
Select cell in workbook. Choose Insert, Object. 
Click the Create from File tab and select fi le. 
Click Insert. Click OK.

Evaluate formula 14-1
Select cell with Trace Error button . Click 
the Evaluate in Formula Auditing toolbar. Click 
Step In to view an argument. Click Step Out 
to leave argument. Click Close after viewing 
each argument.

Export, worksheet as text fi le 18-14
Choose File, Save As. In Save as type box, 
choose Text (tab delimited). Key a fi lename. 
Click Save. Click OK and then Yes.

Export, worksheet to Word 18-13
Select data to export. Click the Copy button . 
Open Word document. Click the Paste button .

Export, worksheet to XML worksheet 18-15
Choose File, Save As. In Save as type box, 
choose XML Spreadsheet. Navigate to folder 
and key a fi lename. Click Save. Click Yes.

File properties, edit 12-4
Choose File, Properties. Click the appropriate 
tab and key or select data. Click OK.

Find, records 19-7
Display data form. Click Criteria. Key criteria, 
with wildcards if necessary. Click Find Next. 
Click Form to return to the forms. Click Close.

Format, create custom 18-3
Select cells. Choose Format, Cells. Click the 
Number tab and select Custom. Key custom 
format in Type text box, Click OK.

Goal Seek 15-9
Select cell to be set to a value. Choose Tools, 
Goal Seek. In To value box, key the target 
value. In By changing cell box, click the cell to 
be adjusted. Click OK. Click OK or Cancel.

Go To Special 12-11
Press Ç +G  or ∞ . Click the appropriate 
button to select category of cells. Click OK.

Import, Access table/query 18-12
Choose Data, Import External Data, New 
Database Query. Choose MS Access Database 
and click OK. Select database fi le and click 
OK. Select table or fi elds. Click Next and enter 
criteria to fi lter data if desired. Click Next 
and enter sorting options if desired. Click Next 
and choose Return Data to Microsoft Excel. 
Click OK.

Import, HTML fi le 18-10
Open Web page in a browser. Size windows 
to display browser and workbook. Select data 
in the Web page and drag to a cell in the 
worksheet.
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Import, text fi le 18-6
Click the Open button . Set Files of type 
to Text fi les. Locate text fi le and double-click. 
Complete wizard dialog box options and click 
Next. Click Finish at the last box.

Import, Word data with copy/paste 18-1
Open document in Word and select data to be 
copied. Click the Copy button . Return to 
workbook. Click in appropriate cell and click 
the Paste button .

Import, Word data with drag/drop 18-4
Open document in Word. Size windows to 
display Word fi le and workbook. Select data 
to be copied. Press Ç . Drag data to appropri-
ate cell in workbook. Release Ç  and then 
release mouse.

Increase indent 11-16
Select cells and click the Increase 
Indent button .

Link, Word document 18-8
Select cell in workbook. Choose Insert, Object. 
Click the Create from File tab. Select fi le. Click 
Insert and select Link to fi le. Click OK.

Link, workbooks 16-9
Open workbooks and arrange windows. Click 
the formula cell in dependent workbook and 
key = to start formula. Click the cell in source 
workbook and then key arithmetic operator. 
Complete formula by clicking where necessary. 
Press e .

Links, break 16-13
Open the dependent workbook. Choose Edit, 
Links. Select the source workbook. Click Break 
Link. Click Break Links again. Click Close.

Links, edit 16-12
Open dependent workbook. Choose Edit, Links. 
Select source workbook. Click Change Source. 
Navigate to new folder, select fi le, and click OK. 
Click Close.

List, create 19-1
Key a row of labels for each column. Enter data 
in columns, leaving no blank rows. Do not mix 
values and text. Name the list.

Locked property 12-16
Right-click the selected cells or object(s). 
Choose Format Cells or Format Picture. Click 
the Protection tab. Select or deselect Locked. 
Click OK.

Macro, delete 13-9
Choose Tools, Macro, Macros. Select macro 
name. Click Delete and choose Yes.

Macro, edit 13-4
Open workbook with macro. Press a +—  to 
open Visual Basic Editor. Make changes in 
Code window. Close editor and save workbook.

Macro, print 13-5
Open Visual Basic Editor. Display macro 
module. Choose File, Print, Current Module in 
the Range group. Choose Code in Print what 
group. Click OK.

Macro, record 13-8
Choose Tools, Macro, Record New Macro. Key 
macro name. Add shortcut if desired. Choose 
location and description. Click OK. Perform 
task. Click the Stop Recording button .

Macro, run from menu 13-2
Choose Tools, Macro, Macros or press a +• . 
Select macro name. Click Run. 

Macro, run from shortcut 13-5
Press Ç +s + and character for shortcut.

Macro, set security level 13-1
Choose Tools, Macro, Security. Set level. 
Click OK.

Outline, create 19-23
Sort the rows by appropriate column. Insert 
blank row below each planned group. Key label 
for group if desired. Select rows for the group. 
Choose Data, Group and Outline, Group.

PivotChart report, create 19-20
Select any cell in PivotTable. Click the Chart 
Wizard button .

PivotTable, AutoFormat 19-11
Select any cell in PivotTable. Click the Format 
Report button  and select AutoFormat. 
Click OK.
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PivotTable, calculated fi eld 19-18
Select column for the calculation. Click 
the PivotTable button on PivotTable toolbar. 
Choose Formulas and then choose Calculated 
Field. Name fi eld and key formula. Click OK.

PivotTable, create 19-10
Choose Data, PivotTable and PivotChart 
Report. Choose Microsoft Excel list or database 
and PivotTable. Select list name or range. 
Select a new or existing worksheet. Click 
Finish. Drag fi elds to row, data, and column 
areas in table template.

PivotTable, custom calculation 19-19
Select cell to show calculation. Click the Field 
Settings button . Click Options. Select from 
Show data as text box. Click OK.

PivotTable, fi eld, delete 19-8
Select fi eld name in PivotTable. Drag fi eld out 
of the table.

PivotTable, fi eld, insert 19-9
Select fi eld name in PivotTable Field List. Drag 
fi eld to the table in desired location.

PivotTable, fi eld, rotate 19-9
Select fi eld name in PivotTable Field List. Drag 
fi eld to another location in the PivotTable.

PivotTable, fi eld settings, edit 19-14
Select fi eld in PivotTable. Click the Field Set-
tings button . Change name or function. 
Click OK.

PivotTable List, create 19-22
Click anywhere in PivotTable. Choose File, 
Save as Web Page. Select Selection: Sheet 
and Add interactivity. Key fi lename and change 
title if desired. Click Publish. Select PivotTable 
and set Add interactivity with to PivotTable 
functionality. Click Publish.

PivotTable, options 19-17
Select any cell in PivotTable. Click the 
PivotTable button on PivotTable toolbar and 
choose Table Options. Make selections and 
click OK.

Range, delete 11-8
Press Ç +£ . Choose name. Click Delete.

Range, go to 11-1
Click the down arrow next to Name Box and 
choose range name.

Range, in formula 11-2
Press £  when range name is needed while 
building the formula. Choose name. Click OK.

Range, name 11-3
Select range of cells. Click the Name Box. Key 
name and press e .

Range, redefi ne 11-10
Press Ç +£ . Edit address in Refers to text 
box. Click OK.

Range names, create 11-5
Select range adjacent to labels. Choose Insert, 
Name, Create. Check options and click OK.

Range names, print 11-11
Position insertion point where printed range 
names should appear. Press £ . Click 
Paste List.

Records, show all 19-11
Click the drop-down arrow for fi ltered fi eld. 
Select (All).

Remove precedent/dependent arrows 14-2
Select cell. Click the Remove Precedent Arrows 
button  or Remove Dependent Arrows 
button .

Reviewing toolbar 17-5
Right-click any toolbar and choose Reviewing.

Scenario, create 15-2
Choose Tools, Scenarios. Click the Add tab. 
Name scenario. Select cells or range name 
in Changing cells text box. Key comment if 
desired. Click OK. Key changing values and 
click OK.

Scenario, edit 15-5
Choose Tools, Scenarios. Choose scenario 
name. Click Edit. Edit Changing cells or com-
ment. Click OK. Edit values and click OK.

Scenario, report 15-6
Choose Tools, Scenarios. Click Summary. 
Choose Scenario summary. In Results cells 
text box, select cells to be shown in report. 
Click OK.
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Scenario, show 15-4
Choose Tools, Scenarios. Choose scenario 
name. Click Show. Close dialog box.

Shared workbook, create 17-1
Choose Tools, Share Workbook. Click Allow 
changes by more than one user at the same 
time on Editing tab. Click OK.

Solver 15-11
Select target cell. Choose Tools, Solver. Choose 
Equal To option. Select cell range in By 
changing cells text box. Click Add to add con-
straints, if desired. Click Solve. Keep solution, 
save it as scenario, or return to original values. 
Click OK.

Sort, multiple columns 19-9
Click in named list. Choose Data, Sort. 
Choose fi rst Sort by fi eld and Ascending 
or Descending. Choose Then by fi elds and 
Ascending or Descending. Click OK.

Sort, single column 19-8
Click in a named list in column to be sorted. 
Click the Sort Ascending button  or Sort 
Descending button .

Subtotals, remove 19-22
Click in subtotaled list. Choose Data, Subtotals. 
Click Remove All.

Subtotals, show 19-21
Sort list by column to be used for subtotaling. 
Choose Data, Subtotals. Choose fi eld for At 
each change in. Choose function. In Add 
subtotal to box, select fi elds that should show 
subtotals. Click OK.

Template, delete 12-5
Click General Templates in New Workbook 
task pane. Select template. Press y . Click 
Yes and then click Cancel.

Template, edit Excel template 12-3
Click the Open button . Navigate to 
folder with Spreadsheet Solutions templates. 
Open template. Save template with same or dif-
ferent name.

Template, save 12-18
Press ≠ . Key template name in File name 
box. Click the down arrow next to Save as type 
and choose Template. Navigate to appropriate 
Save in folder. Click Save.

Template, use Excel template 12-1
Click General Templates in New Workbook 
task pane. Click the Spreadsheet Solutions tab. 
Double-click the template.

Toolbar, add menu/button 13-14
Click the toolbar. Choose Tools, Customize. 
Click the Commands tab and choose category. 
Drag menu name or button to toolbar. 
Click Close.

Toolbar, create 13-14
Choose Tools, Customize. Click the Toolbars 
tab and click New. Key toolbar name. Click 
Close.

Toolbar, delete 13-20
Right-click the toolbar. Choose Customize. 
Click the Toolbars tab and select toolbar name. 
Click Delete, Click OK. Click Close.

Toolbar, display/hide 13-11
Right-click any toolbar. Choose toolbar to be 
displayed/hidden.

Toolbar, modify 13-16
Choose Tools, Customize. Click the Commands 
tab. Click the button or menu name. Click 
Modify Selection, Choose option from shortcut 
menu and make changes. Click Close.

Trace dependents 14-3
Select cell. Click the Trace Dependents 
button .

Trace error 14-8
Select cell. Click the Trace Error button .

Trace precedents 14-2
Select cell. Click the Trace Precedents 
button .

Trendline, add 15-8
Select chart. From Chart menu, choose Add 
Trendline. Choose type of trendline on Type 
tab. On Options tab, set number of periods for 
forecasting. Click OK.
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Unprotect, workbook 12-20
Choose Tools, Protection, Unprotect Workbook. 
Key password if prompted. Click OK.

Unprotect, worksheet 12-20
Choose Tools, Protection, Unprotect Sheet. Key 
password if prompted. Click OK.

Validate, data 12-8
Select cells. Choose Data, Validation. Click the 
Settings tab. Choose options in Allow box. 
Complete other text boxes if necessary. Click 
OK.

Validate, error alert 12-9
Select cells. Choose Data, Validation. Click the 
Error Alert tab. Choose option in Style list. Key 
title in Title box. Key message in Error message 
box and click OK.

Validate, input message 12-10
Select cells. Choose Data, Validation. Click the 
Input Message tab. Key title in Title box. Key 
message in Input message box. Click OK.

Watch Window, display/hide 14-6
Click the Show Watch Window button .

Web query, create 18-11
Choose Data, Import External Data, New Web 
Query. Key Web address in Address text box 
and press e . Click the table marker for 
data to be imported. Click Import and choose 
Existing worksheet. Click OK.

Workspace, create 16-14
Open workbooks and arrange windows. Choose 
File, Save Workspace. Navigate to folder and 
key fi lename. Click Save.


